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2 Overview

Once SciFinder Scholar is successfully installed (see your Site
Administrator for details), you are ready to begin exploring and
retrieving chemical and science-related information.  If SciFinder
Scholar does not appear to be installed properly, please contact your
Site Administrator.

Chapter 2 introduces you to:

• Logging on to SciFinder Scholar
• SciFinder Scholar window and its menu and toolbar
• SciFinder Scholar tasks

- Explore by Chemical Substance or Reaction
- Explore by Research Topic
- Explore by Author Name
- Explore by Document Identifier
- Explore by Company Name/Organization
- Browse Table of Contents

• Saving and printing files
• Ending a task
• Exiting SciFinder Scholar



2-2  Chapter 2 Overview

To start SciFinder Scholar, open the SciFinder Scholar application from
the Start menu (Windows) or double-click the SciFinder Scholar icon
(Macintosh).  The SciFinder Scholar splash screen is displayed, and
you are connected to CAS.

The SciFinder Scholar window is displayed.  It contains the Main
Menu, the Main Menu Toolbar, and the Explore dialog box.

Starting
SciFinder
Scholar

Main Menu

Explore
dialog box

Main Menu
Toolbar
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Explore allows you to look for scientific information dating from 1947 to
present in the CAS databases as well as information dating from 1958
to present in the MEDLINE database.  You may choose to explore by:

• Chemical Substance or Reaction
• Research Topic
• Author Name
• Document Identifier
• Company Name/Organization

Click the icon for the task you want to perform.

Explore Dialog
Box
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Browse Table of
Contents

Click the Chemical Substance or Reaction icon from the Explore
dialog box to display the Explore by Chemical Substance dialog
box.

SciFinder Scholar offers you three ways to retrieve chemical
substances:

• Chemical Structure
• Substance Identifier, e.g., a CAS Registry Number
• Molecular Formula

SciFinder Scholar offers one way to retrieve chemical reactions:

• Chemical Structure

For detailed information about Explore, refer to Chapters 3-6.

Browse Table of Contents allows you to scan a list of more than 1600
key scientific journals covered by the CAS databases.  You can view
the tables of contents and link to full-text options for selected journals.

For detailed information about Browse Table of Contents, refer to
Chapter 9, Browse Journal Tables of Contents.

Explore by Chemical
Substance or
Reaction
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The following tables list the commands located on the SciFinder
Scholar Main Menu.  The menu items and their functions are given in
the tables.

The File menu provides basic window management commands.

Main Menu

File Menu

Menu Item Definition

New Task Displays the Explore dialog box with the available
options in SciFinder Scholar

Save As

Allows you to save an answer set in one of several
formats, e.g., Rich Text Format.  See the Saving
Files section later in this chapter for more
information.

Print Setup
(Windows) or
Page Setup
(Macintosh)

Allows you to select parameters for printing

Print Prints the displayed window

Full Text Options

Opens your web browser and links to ChemPort.
This allows you to access the full document of
selected references.  For details, see Accessing
Full-Text Documents in Chapter 8.

Exit SciFinder
Scholar
(Windows) or
Quit (Macintosh)

Quits SciFinder Scholar and closes the application
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Edit Menu The Edit menu provides standard editing functions.

Menu Item Definition

Cut
Removes a selected block of text and/or graphics
and places it on the clipboard to be used or pasted
in other applications

Copy
Copies a selected block of text and/or graphics to
the clipboard to be used or pasted in other
applications

Paste Places the contents from the clipboard at the
location of your cursor

Select All Selects everything in the current window

Unselect All Unselects anything selected
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The View menu provides options for displaying references,
substances, or reactions in the SciFinder Scholar window.  Options
that are grayed out are not available for your current answer set.  For
example, Title Order is not applicable to substance answer sets.

View Menu

Menu Item Definition

Compact References: Displays the title of the article or patent
Substances: Displays the chemical structure

Standard

References: Displays the bibliographic information
with the author names listed first
Substances: Displays the chemical structure, CAS
Registry Number, the approximate number of
references citing the substance, and, if available,
links to additional information

Summary

References: Displays the bibliographic information
with the title listed first followed by the abstract, and,
if applicable, patent family information
Substances: Displays the chemical structure, CAS
Registry Number, CA Index Name, the approximate
number of references citing the substance, and, if
available, links to additional information

Full

References: Displays the entire record, listing the
bibliographic information (title first), followed by the
abstract, and, if applicable, patent family information,
indexing, supplementary terms, controlled terms,
CAS Registry Numbers, chemical names, and
citations
Substances: Displays the entire record including the
chemical structure, CAS Registry Number, chemical
names, molecular formula, a list of STN files that
contain information about the substance, property
data, the approximate number of references citing
the substance, and, if available, links to additional
information

Accession
Number Order

Displays results in the order they were accessed,
i.e., the order they were added to the database

Similarity Order Displays substance results grouped by similarity to
each other

Title Order Displays reference results alphabetically by title

Year, Title Order Displays reference results alphabetically by title,
placing titles from the same year together

Reverse Order Displays results in the order opposite of the current
display
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Task Menu The Task menu provides tools for the tasks available in SciFinder
Scholar.

Menu Item Definition

Explore Displays the Explore options in SciFinder
Scholar

    Chemical
    Substance or
    Reaction

Displays an Untitled Structure Drawing window,
the Explore by Substance Identifier dialog
box, or the Explore by Molecular Formula
dialog box

    Research Topic
Displays the Explore by Research Topic
dialog box

    Author Name Displays the Explore by Author Name dialog
box

    Document Id
Displays the Explore by Document Identifier
dialog box

    Company Name
Displays the Explore by Company Name
dialog box

Browse Journals Accesses the Browse Table of Contents feature
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Tools Menu The Tools menu provides the tools available for the tasks in SciFinder
Scholar.

Menu Item Definition

Analyze
References

Allows you to create subsets of reference answer
sets on the basis of specific criteria, e.g.,
Publication Year.  Then you can select only answers
that are appropriate to your research needs.

Analyze
Substances

Allows you to evaluate answers on the basis of real-
atom attachments, variable or R group composition,
or precision

Refine

Allows you to specify additional search criteria for
an existing answer set. This can reduce the number
of answers and pinpoint results that better match
your needs.

Keep Allows you to retain the selected references,
reactions, or substances and discards the others

Get Related Allows you to retrieve citations or substances or
extend your search with eScience

Task History Displays the history of your current task

Back Displays the previous screen

Forward Displays the next screen

Edit Preferences Opens the Preference Editor.  Refer to Appendix
A, Preferences, for details.

Database Settings Opens the Database tab of the  Preference Editor.
Refer to Appendix A, Preferences, for details.

Statistics Monitor Displays information about your server, port,
memory, and file access speed

Internet Opens your web browser and links to SciFinder
Scholar, CAS, ChemPort, and other web sites
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The Help (Windows) or SciFinder Help (Macintosh) menu provides
access to help while you are using SciFinder Scholar.

Macintosh users may have an additional Help menu that is unrelated
to SciFinder Scholar.

Help (Windows) or
SciFinder Help
(Macintosh) Menu

Menu Item Definition

SciFinder Scholar
Help Opens SciFinder Scholar's online Help file

Contents and
Index Opens SciFinder Scholar's online Help file

User Guide Open the SciFinder Scholar User Guide in PDF
format

Message of the
Day

Allows you to view the message of the day from
CAS administrators

About SciFinder
Scholar Contains copyright and version
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The Main Menu Toolbar consists of buttons that take you quickly to
the function of your choice.

Main Menu
Toolbar

Default Toolbar
Buttons Definition

New Task Displays the Explore dialog box

Back Displays the previous screen

Forward Displays the next screen

Print Prints the displayed window according to the setup
defined in your Print Setup

Save As Allows you to save an answer set in several different
formats, e.g., Rich Text Format

Full Text Opens your web browser and links you to ChemPort

Prefs
Opens the Preferences Editor, which allows you to
customize your SciFinder Scholar session.  See
Appendix A, Preferences, for details.

Database
Opens the Databases tab of the Preferences
Editor.  See Appendix A, Preferences, for details.

History Displays the history of your current session

Internet Opens your web browser and links to SciFinder
Scholar, CAS, ChemPort, or other web sites

Help Opens the SciFinder Scholar Help window

Exit Quits SciFinder Scholar and closes the application
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Reference, substance, and reaction answer sets as well as other
displays may be saved to a file on your computer by using the Save
As command.

To save an item for the first time, select Save As from the File menu
or click the Save As button on the Main Menu Toolbar.  A Save As or
Save File As dialog box is displayed.

1. Select a folder where you want the item to be saved.
2. Type a file name in the File name box.
3. Select a file type for saving the file, e.g., Rich Text Format (.rtf).
4. Click Save.  The file is saved and you are returned to the previous

window.

Reference and substance records can be saved in several different
formats: Plain ASCII (.txt), Rich Text Format (.rtf), Quoted Format
(.txt), Tagged Format (.txt), and Answer Keys (.txt).  Reaction answer
sets can be saved in Plain ASCII (.txt) and Rich Text (.rtf) formats only.
For information on saving structure queries, see Appendix B.

Plain ASCII format gives a simple text representation of what you
would see if you printed your results.  Rich Text Format is similar, but
preserves some of the formatting, color in some cases, and graphics
if present.  The Options button for both of these formats allows you to
select the amount of information and all or selected answers.

Quoted format allows you to create the type of delimited file you want.
Use the Options button to define the Quoted format to your needs.
For example, a typical Comma Separated Values format would use
double quotes for the Quote Character and a comma for the Delimiter.
A tab-delimited file would replace the comma with a tab.  Delimited
files can be useful for importing into database programs such as
Microsoft® Access, Lotus® Notes, and Excel.

Tagged format files are typically used for importing data into
bibliographic database programs such as EndNote®, ProCite®, and
Reference Manager®.  The Options button allows you to choose all or
selected answers.  Import requires the use of a special file that
defines the tags.  The producer of your bibliographic database
application should be able to provide you with this file.  If you need
additional help, please contact your Site Administrator.

Answer Keys can be used for input into the Explore by Document
Identifier function and other query functions.  The Options button
allows you to customize this list.

Saving Files

File Formats and
Options
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Ending a Task

Exiting
SciFinder
Scholar

Reference, substance, and reaction answer sets as well as other
displays may be printed to your local printer.  Select the records you
want to print; otherwise, SciFinder Scholar will print the entire answer
set.

To print an item, select Print from the File menu or click the Print
button on the Main Menu Toolbar.  The Print dialog box is displayed.

Choose from the options available.  Then click OK (Windows) or Print
(Macintosh).  Your item is printed, and you are returned to the
previous window.

To end any task and begin a new task, select New Task from the File
menu or click the New Task button on the Main Menu Toolbar.

To leave a SciFinder Scholar session, select Exit SciFinder Scholar
(Windows) or Quit (Macintosh) from the File menu or click the Exit
button on the Main Menu Toolbar.

Printing
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4 Exploring by Exact Chemical
Structure

SciFinder Scholar’s exact structure searching capability allows you to
draw chemical structures and retrieve exact or related structure
candidates, which may include:

• The structure exactly as you have drawn it
• Stereoisomers
• Tautomers (including keto-enol)
• Coordination compounds
• Charged compounds
• Radicals or radical ions
• Isotopes
• Polymers in which the structure is a monomer

Substance answers provide:

• substance identification information
• commercial sources and regulatory information
• bibliographic references and abstracts

Chapter 4 introduces structure searching with SciFinder Scholar.  You
will become familiar with:

• Structure Drawing window
• Structure Drawing Menu
• Structure Drawing tool palettes
• Exact structure searches
• Performing an exact structure search
• Viewing substance details
• Refining your structure query
• Retrieving references for your substance
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To access this feature, click the Chemical Substance or Reaction
icon in the Explore window.  Then click Chemical Structure.  An
Untitled Structure Drawing window is displayed.

The Structure Drawing window includes:
1 Structure Drawing Menu
2 Vertical Tool Palette containing drawing tools
3 Horizontal Tool Palette containing the Common Atoms and Bonds
4 Current Atom box
5 Scaling Factor box
6 Blank screen for Structure Drawing

Accessing
Explore by
Chemical
Structure

1

2

53

6

4
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The Structure Drawing Menu provides the tools necessary to create
a structure.

The File menu provides basic structure and window management
commands.

File Menu

Structure
Drawing Menu

���

���

Menu Item Definition

New Opens a new Untitled Structure Drawing window

Open Opens an existing structure that was previously
saved

Close Closes the current Structure Drawing window and
displays the Explore window

Save
Saves the structure in the Structure Drawing window
to the file that is currently open (there are no dialog
boxes)

Save As Allows you to save a structure in an alternate format,
e.g., MDL molfile, or with a different name

Revert Discards all changes to the current structure and
reverts to the last saved structure

Get Substances Searches for substances matching the drawn
structure, including tautomers, ions, etc.

Get
Reactions

Searches for reactions that contain your structure
query

Preview Allows you to estimate the number of answers and
review sample answers for a substructure search

Print Setup
(Windows) or
Page Setup
(Macintosh)

Selects print settings for structures to be printed

Print Prints the current structure

Exit SciFinder
Scholar
(Windows) or
Quit (Macintosh)

Quits SciFinder Scholar and closes the application
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The Edit menu provides standard and SciFinder Scholar-specific
editing features.

���

Edit Menu

Menu Item Definition

Undo
Erases the last edit function and restores the item to
its previous condition.  Multiple Undo functions are
permitted.

Redo Restores the item that you "undid" when you used
the Undo command

Cut
Removes a selected block of text and/or a structure
and places it on the clipboard to be used or pasted
in other applications

Copy
Copies a selected block of text and/or a structure to
the clipboard to be used or pasted in other
applications

Paste Places the contents from the clipboard at the
location of your cursor

Clear Removes a selected block of text or graphics

Select All Selects everything in the Structure Drawing window

Unselect All Unselects anything selected

Clear All Clears the entire Structure Drawing window

Repaint Forces a screen update

Delete All
Mappings

Removes all mappings that you applied with the
Reaction Mapping tool
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The View menu provides options for customizing the display of atoms
and bonds in a structure drawing.  These options work as toggle
switches.  When you select an option, a check mark appears next to
it.  To deselect an option, select it again and the check mark
disappears.

Dot Atoms and Position Numbers cannot be set at the same time.
Selecting one option deselects the other.

You may set defaults for your session in the Drawing tab of the
Preference Editor.

View Menu

Menu Item Definition

Dot Atoms Toggles the display of carbon atoms as dots or
angles.  The default is angles.

Position Numbers Toggles the display of position numbers on or off.
The default is off.

Status Bar
Toggles the display of the status bar that displays
the molecular formula and formula weight of the
current structure.  The default is on.
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Menu Item Definition

Valency Checking Checks valencies as you draw and displays a
warning when valency problems may exist

Fix Drawing
Angles

Toggles bond angles as fixed or variable.  The
default uses variable angles.  The fixed angle
applies only to individually drawn bond angles, not to
chains or rings made with tools or templates.

Fix Drawing
Length

Toggles drawing bonds as fixed or variable lengths.
The default displays variable bond lengths.  The
fixed length applies to chains and rings as well as to
individually drawn bonds.

Check Overlaps Checks if any nodes or bonds overlap and displays
a message if any do

Unlock All
Positions

Unlocks all nodes in the Structure Drawing window
that you have locked with the Lock Out
Substitution tool or the Lock All Positions option

Lock All
Positions

Locks out from substitution all nodes in the Structure
Drawing window

Reverse Shortcut Displays a selected shortcut in the opposite
orientation

Flip Horizontal Flips selected structure(s) or fragment(s) around the
vertical axis, creating a mirror image

Flip Vertical Flips selected structure(s) or fragment(s) around the
horizontal axis, creating a mirror image

Fuse Fragments Joins two fragments at selected nodes or bonds

Edit Preferences Opens the Preference Editor.  Refer to Appendix
A, Preferences, for details.

Database Settings
Opens the Databases tab of the Preference
Editor.  Refer to Appendix A, Preferences, for
details.

���

���

The Tools menu provides options to help you draw your structure,
including tools to edit your Preferences.  The first three options work as
toggle switches.  When you select Valency Checking, Fix Drawing
Angles, or Fix Drawing Length, a check mark appears next to the
option.  To deselect an option, select it again and the check mark
disappears.  Session defaults for these options may be changed in the
Drawing tab of the Preference Editor.

Tools Menu
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The Template menu provides templates of predefined structures.
Templates may be selected and then placed into your Structure
Drawing window.

Template Menu

Menu Item Definition

Monocarbocyclic Displays structure templates of single rings
containing only carbon atoms

Bicarbocyclic Displays structure templates of bicyclo rings
containing all carbon atoms

Polycarbocyclic Displays structure templates of multi-ring systems
containing all carbon atoms

N-containing Displays structure templates of rings with one or
more nitrogens

O-containing Displays structure templates of rings with one or
more oxygens

S-containing Displays structure templates of rings with one or
more sulfurs

NOS-containing Displays structure templates of rings with one or
more nitrogens, oxygens, and sulfurs

Alkaloid Displays alkaloid structure templates

Amino Acid Displays amino acid structure templates

Carbohydrate Displays carbohydrate structure templates

Nucleic Acid Displays nucleic acid structure templates

Steroid Displays steroid structure templates

Coordination Displays templates of a specific metal with different
coordination configurations

Misc. Displays a variety of structure templates
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The Help (Windows) or SciFinder Help (Macintosh) menu provides
assistance for using SciFinder Scholar.

Macintosh users may have an additional Help menu that is unrelated
to SciFinder Scholar.

Help (Windows) or
SciFinder Help
(Macintosh) Menu

Menu Item Definition

SciFinder Scholar
Help Opens SciFinder Scholar's online Help file

Contents and
Index Opens SciFinder Scholar's online Help file

User Guide Open the SciFinder Scholar User Guide in PDF
format

Message of the
Day

Allows you to view the message of the day from
CAS administrators

About SciFinder
Scholar Contains copyright and version
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The Vertical Tool Palette contains tools to draw and modify your
structure.  To use a tool, click its icon.  When the cursor is placed in
the Structure Drawing window, it changes to resemble the tool you
selected.

*Valid only for substructure or reaction searching.
**Valid only for reaction searching.

Vertical Tool
Palette

Atom Menu tool

Pencil tool

X Menu tool*

Cyclopentadiene tool

Benzene tool

Template tool

Eraser tool

Selection tool

Positive Charge tool

Lock Out
Substitution tool*

Reaction Site
Marking tool**

Reaction Arrow
tool**

Chain tool

Short Menu tool

R Group tool*

Cyclopentane tool

Cyclohexane tool

3-15 Member
Ring tool

Lasso tool

Rotation tool

Negative Charge tool

Lock Out Rings tool*

Reaction Role tool**

Reaction Mapping
tool**

Functional Groups
tool**
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The Pencil tool is used to place or change nodes or bonds.  Nodes
can be atoms, shortcuts, or variables.  Click the Pencil tool icon to
activate the tool and draw nodes and bonds with the current atom/bond
type.  When you click the Pencil tool icon, the cursor changes to
resemble a pencil.

To draw one node bonded to another node:

1. Place the pencil where you want the first node to appear.
2. Press and hold the mouse button and drag the cursor to the point

where you want the second node.  Release the mouse button.

When the nodes are carbons (the default atom), the atomic symbol,
C, is not displayed.  The C atom symbol is displayed only when it
stands alone. To verify the placement of all carbons, select Dot
Atoms from the View menu.

Nodes and bonds can be applied by using the Horizontal Tool
Palette, Atom, Short, and X Menu tools, or the Current Atom box.
(See the corresponding sections for these items later in this chapter.)

• Choose a node and/or bond to apply.  Click the Pencil tool in the
Structure Drawing window to draw the node.  Click and drag the
Pencil tool to draw the bond with nodes on both ends.

• Similarly, you may replace an existing node or bond.  Choose a
node or bond to apply.  Place the tip of the Pencil tool over the
node or bond to be replaced.  It becomes highlighted.  Click the
mouse button and the existing node or bond is replaced.

The Chain tool is used to draw chains of lengths ranging from 1 to 30
atoms.  When you click the Chain tool icon, the cursor changes to a
chain.

To draw a chain, place the chain arrowhead where you want it to
appear.  Press your mouse button and drag the cursor to the desired
length.  A number indicating the chain length appears as you drag the
tool to let you see how many atoms are in the chain you are drawing.

Release the mouse button when you have drawn your chain to the
appropriate length.  The number no longer displays.

To reverse the orientation of the attachment of a chain, press and
hold the <Shift> key while drawing the chain.

Pencil Tool

Chain Tool
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The Atom Menu tool is used to select an atom to insert into your
structure.  The atom you select is the new default for the current
SciFinder Scholar session and remains the default until you select a
new atom, shortcut, variable, R group or functional group.  When this
tool is selected, the cursor automatically changes to the Pencil tool.

To use the Atom Menu tool, click its icon and hold.  An atom menu
portraying the Periodic Table is displayed.  Only those atoms that are
available for structure searching with SciFinder Scholar are shown in
the Periodic Table.

To select an atom, drag the cursor to the atom you want to use.
When the atom you want is highlighted, release the mouse button.
This atom is placed in the Current Atom box on the Horizontal Tool
Palette.

Position the Pencil tool in your Structure Drawing window or on an
existing node and click.  The new atom is inserted into your drawing.

The Short Menu (Shortcuts) tool is used to select a shortcut to insert
into the structure.  The shortcut you select is the new default for the
current SciFinder Scholar session and remains the default until you
select a new atom, shortcut, variable, R group, or functional group.
When this tool is selected, the cursor automatically changes to the
Pencil tool.

To use the Short Menu tool, click its icon and hold.  A shortcut menu
is displayed.

To select a shortcut, drag the cursor to the shortcut you want to use.
When the shortcut you want becomes highlighted, release the mouse
button.  The selected shortcut is placed in the Current Atom box on
the Horizontal Tool Palette.

Position the Pencil tool in your Structure Drawing window or on an
existing node and click.  The shortcut is inserted into your drawing.

After placing a shortcut, you may choose to reverse its orientation,
e.g., MeO to OMe.  To do so, select the shortcut with the Selection
tool (refer to its section later in this chapter for details).  Select
Reverse Shortcut from the Tools menu.

Terminal shortcuts are by definition locked, i.e., shortcuts will not
contain any substitutions in the answer set.  Shortcuts cannot be
unlocked with the Lock Out Substitution tool discussed later in this
chapter.

Atom Menu Tool

Short Menu Tool
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The X Menu (Variables) tool is used to select a fixed variable to
insert into a substructure (or reaction structure) query.  The variable
you select is now the new default and remains the default until you
select a new atom, shortcut, variable, R group, or functional group.
When this tool is selected, the cursor automatically changes to the
Pencil tool.

To use the X Menu tool, click its icon and continue to press the
mouse button.  A menu of available variables is displayed.

Drag the cursor to the variable you want to use.  When the variable
you want becomes highlighted, release the mouse button.  The
variable you select is placed in the Current Atom box on the
Horizontal Tool Palette.

Position the Pencil tool in an area of your Structure Drawing window
or on an existing node and click.  The new variable is inserted into
your drawing.

When Ak is drawn, it is surrounded by a box, i.e., locked.  With Ak in
the locked state, answers will be retrieved in which Ak is any linear or
branched, saturated or unsaturated carbon chain with no substitution
on the carbon nodes.  To unlock Ak, click the Lock Out Substitution
tool.  Then place the cursor over the Ak to highlight it and click.  The
box is removed.  With Ak in the unlocked state, retrieved answers
may contain carbon chains that are substituted with any atom.  For
more details on locking, see the Lock Out Substitution Tool section
later in this chapter.

The R Group tool is used to create R groups to insert into a
substructure query.  R groups are used to define two or more values
(maximum of 20) that may occur at the position.

To use the R Group tool, click its icon.  The R-group Definitions
dialog box appears near the bottom of the screen with R1 highlighted.
R1 becomes the new default for the current SciFinder Scholar session
and remains the default until you select a new atom, shortcut, variable,
R group, or functional group.

To define R1, click the Atom, Short, and/or X menu button within the
R-group Definitions dialog box and choose atoms, shortcuts, and/or
variables that are allowed values for R.  Or, type the atoms, shortcuts,
and/or variables into the R1 box, separated by commas.

���X Menu Tool

���

R Group Tool ���

���
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To define additional R groups, move the cursor to the R2, R3, etc.,
boxes.  You may define up to 10 R groups.

To place an R group in a structure, click the appropriate R group in
the R-group Definitions dialog box and use the Pencil tool to add it
to your structure.

The Cyclopentadiene tool is used to draw cyclopentadiene rings.

To use the Cyclopentadiene tool, click its icon.  The cursor
automatically changes to resemble a cyclopentadiene ring.

To place a cyclopentadiene ring, position the cursor in your Structure
Drawing window and click.

To fuse a cyclopentadiene ring to an existing node or bond, point the
tip of the Cyclopentadiene tool on a node or bond until it is
highlighted and click.

Cyclopentadiene rings may be oriented around a node by continuing
to press your mouse button while rotating the mouse.  Release your
mouse button when the ring is oriented correctly.

The Cyclopentane tool is used to draw cyclopentane rings in your
structure.

To use the Cyclopentane tool, click its icon.  The cursor changes to
resemble a cyclopentane ring.

To place a cyclopentane ring, position the cursor in your Structure
Drawing window and click.

To fuse a cyclopentane ring to an existing node or bond, point the tip
of the Cyclopentane tool on the node or bond until it becomes
highlighted and click.

Cyclopentane rings may be oriented around a node by continuing to
press your mouse button while rotating the mouse.  Release your
mouse button when the ring is oriented correctly.

Cyclopentane Tool

Cyclopentadiene Tool
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The Benzene tool is used to draw benzene rings.

To use the Benzene tool, click its icon.  The cursor changes to
resemble a benzene ring.

To place a benzene ring, position the cursor in your Structure Drawing
window and click.

To fuse a benzene ring to an existing node or bond, point the tip of the
Benzene tool on the node or bond until it becomes highlighted and
click.

Rings may be oriented around a node by continuing to press your
mouse button while rotating the mouse.  Release your mouse button
when the ring is oriented correctly.

The Cyclohexane tool is used to draw cyclohexane rings.

To use a Cyclohexane tool, click its icon.  The cursor changes to
resemble a cyclohexane ring.

To place a cyclohexane ring, position the cursor tip in your Structure
Drawing window and click.

To fuse a cyclohexane ring to a node or bond, point the tip of the
Cyclohexane tool on a node or bond until it becomes highlighted and
click.

Rings may be oriented around a node by continuing to press your
mouse button while rotating the mouse.  Release your mouse button
when the ring is oriented correctly.

The Template tool is used to place a template that you have selected
from the Template menu.  This tool is available only after you have
selected a template from the Template menu.

To use this tool, select a structure template from the Template menu
located on the Structure Drawing Menu.  SciFinder Scholar displays
structures conforming to your selection.  Click the structure template
that you want to use.  You are returned to the Structure Drawing
window.

Position the cursor tip in the Structure Drawing window and click.  The
template structure appears in the Structure Drawing window.

You may not attach a template structure to an existing node or bond.

Benzene Tool

Cyclohexane Tool

Template Tool
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The 3-15 Member Ring tool is used to draw 3-15 member rings and
ring systems.  When you click this icon, the Ring Tool dialog box is
displayed.

Accept the default ring size, 6, or type a number between 3 and 15.
Click OK.  Your cursor changes to resemble the 3-15 Member Ring
tool icon.

To place a ring, position the cursor tip in your Structure Drawing
window and click.

You may attach a 3-15 member ring to an existing node or bond.
Position the tip of the 3-15 Member Ring tool on the node or bond
until it becomes highlighted and click.

Rings may be oriented around a node by continuing to press your
mouse button while rotating the mouse.  Release your mouse button
when the ring is oriented correctly.

Fused ring systems that consist of 4-, 5-, or 6-member rings may also
be drawn in one step by clicking the 3-15 Member Ring tool icon.
Type a ring system in the Ring Tool dialog box.  Control the direction
of fusion by typing a U (Up) or a D (Down).  The initial default direction
is from left to right.  After changing a direction, the fusion continues in
the new direction until you change it.

For example, type 66U6D5 to draw a steroid ring system.  Place your
cursor in the Structure Drawing window and click.

3-15 Member Ring
Tool
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The Eraser tool is used to delete a node or bond from your structure.
When you click the Eraser tool icon, the cursor changes to resemble
a pencil eraser.

To delete a node, position the tip of the eraser on a node.  The node
is highlighted.  Click and the node and any bonds attached to it are
removed.

To remove a bond, place the eraser in the middle of the bond.  The
bond is highlighted.  Click to remove the bond.  Terminal nodes at
either end of the bond are removed, but nonterminal nodes are not.

The Lasso tool is used to select a structure.  Once selected, you may
move it on your screen, cut, copy, or delete it.  If a shortcut is
selected, you may reverse it if applicable.

To lasso (select) an object, click the Lasso tool icon.  The cursor
changes to resemble a lasso. Then, press and hold your mouse
button and drag the lasso cursor around the structure.  A line (lasso)
appears around the structure fragment as you drag the cursor.
Release the mouse button when the entire fragment is enclosed.

To move the lassoed structure fragment, place the lasso cursor inside
the lassoed area.  The cursor changes to a hand.  Press and hold
your mouse button while dragging to a new location.  Release the
button and the selected fragment is relocated to the new location.

To remove the lassoed structure fragment, select Cut or Clear from
the Edit menu or press your <Delete> key.  The selected fragment is
removed from the structure.  If you select Cut, the structure fragment
is removed and placed on your clipboard.

To place a copy of the structure fragment on your clipboard, select
Copy from the Edit menu.  The selected fragment is now in the
structure and on your clipboard.

To lasso a single node, align the point of the Lasso tail on the node
and click.  The node is enclosed in a box.

The Selection tool is used to select individual nodes, bonds, structure
fragments, or entire structures.  Selected items may be moved, cut,
copied, or deleted.  Selected shortcuts may be reversed, if applicable.

To select an item, click the Selection tool icon.  The cursor changes
to resemble an arrow.  Place the arrow tip on a single node or bond
and click.  The item becomes highlighted.

Eraser Tool

Lasso Tool

Selection Tool
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To select more than one node or bond, press and hold the <Shift>
key while you click each item that you want to select.  Release the
shift key and the mouse button.  All of the items you clicked are
highlighted.

To select several nodes and bonds quickly, click and hold the mouse
button while you drag the cursor to draw a box around the area
containing the nodes and bonds.  Release the mouse button.  All
items within the box you drew are highlighted.

To select an entire structure, double-click any node or bond in the
structure.  The entire structure becomes highlighted.

To move a segment of a structure, select one or more nodes or
bonds.  Place the tip of the arrow cursor on a highlighted node or
bond and press and hold your mouse button.  Drag the node or bond
to a new orientation and release your mouse button.  All selected
nodes or bonds will move in concert.

To move an entire structure, select the structure.  Place the tip of the
arrow cursor on any part of the structure and press your mouse
button.  Drag the structure to a new location and then release your
mouse button.

To cut a selected item, select Cut from the Edit menu.  The item is
removed from the Structure Drawing window and placed on the
clipboard.

To copy a selected item, select Copy from the Edit menu.  A copy of
the item is placed on the clipboard for pasting.

To delete a selected item, press the <Delete> key.

To reverse a shortcut, e.g., change MeO to OMe, click the shortcut to
highlight it.  Then select Reverse Shortcut from the Tools menu.

To deselect highlighted nodes, bonds, or structures, click in an open
area of the Structure Drawing window.

The Rotation tool is used to rotate a structure fragment either
clockwise or counterclockwise around the axis of a node you select.

To rotate a structure or structure fragment, click the Rotation tool
icon.  The cursor changes to resemble the icon.  Then click the node
around which you want to rotate and continue to press your mouse
button as you move the mouse.  The fragment rotates as you move
the mouse.  When the object is at the orientation that you want,
release your mouse button.

Rotation Tool
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The Positive Charge tool is used to place a positive (1+) charge on a
node.  When you select this tool, the cursor changes to resemble the
positive charge icon.

To insert a positive charge, click the Positive Charge tool icon.  Then
place the cursor tip on a node.  The node becomes highlighted.  Click
and a positive charge is placed on that node.  To increase the charge,
continue to click.

To reduce the charge, use the Negative Charge tool.

The Negative Charge tool is used to place a negative (1-) charge on
a node.  When you select this tool, the cursor resembles the negative
charge icon.

To insert a negative charge, click the Negative Charge tool icon.
Then place the cursor tip on a node.  The node becomes highlighted.
Click and a negative charge is placed on that node.  To decrease the
charge, continue to click.

To increase the charge, use the Positive Charge tool.

The Lock Out Substitution tool is used in substructure searching to
block additional substitution at a particular node.

To lock a node, click the Lock Out Substitution tool icon.  The cursor
changes to resemble that icon.

Place the tip of the key in the cursor over a node until it is
highlighted.  Click and a box appears around that node.  You may lock
any number of nodes within a structure.

Terminal shortcuts from the Short Menu, with the exception of Ak, are
by definition locked, i.e., you cannot mark them with a box.

The Lock Out Rings tool is used in substructure and reaction
searching to isolate rings from additional fusion and to prevent bonds
in a chain system from being part of a ring.

To isolate a ring and/or chain system, click the Lock Out Rings tool
icon.  The cursor changes to resemble that icon.

Place the tip of the key in the cursor on any segment of a ring or chain
system until it becomes highlighted.  Click and the entire ring or chain
system becomes bold.  You may lock out any number of ring or chain
systems in your reaction structure.

Lock Out
Rings Tool

���

���

Positive Charge Tool

Negative Charge Tool

Lock Out
Substitution Tool

���

���
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The Reaction Site Marking tool is used to mark a bond in a reaction
structure that must be modified in the reaction.  When you click this
icon, the cursor changes to resemble the Reaction Site Marking tool.

To mark a bond, click the Reaction Site Marking tool icon.  Place the
cursor tip on the bond that you want to mark until it is highlighted and
click.  A double line is placed perpendicular to the bond to identify the
marked bond.

You may mark as many bonds as you like in the reaction structure.
However, marking bonds creates a very specific query and may result
in a smaller answer set than one in which bonds are not marked.

The Reaction Role tool is used for reaction searches to identify
structures as Reactant/Reagent, Product, or Any Role.

To assign a role, click the Reaction Role tool icon.  Place the cursor
on the structure and click.  A Reaction Roles dialog box is displayed.
Choose a role for the structure and click OK.  A role label appears
below the structure.

To replace a role, click the Reaction Role tool icon and position the
cursor on the structure or the role label.  Click and the Reaction
Roles dialog box is displayed.  Choose a different role and click OK.
The previously assigned role is overridden, and the new role appears
below the structure.

To have reaction roles assigned automatically, use the Reaction
Arrow tool described in the next section.  If you attempt a reaction
search and any part of your reaction has not been assigned a role, the
Unspecified Roles dialog box appears, where you may choose to
assign “Any Role” to the structure or return to the Structure Drawing
window by clicking Cancel.

Reaction Site
Marking Tool

���

Reaction
Role Tool

���
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The Reaction Arrow tool is used for reaction searches and provides
automatic assignment of roles for structures in the Structure Drawing
window.

To draw an arrow, click the Reaction Arrow tool icon.  The cursor
changes to resemble a horizontal arrow.  Position the cursor where
you would like to draw the arrow.  Click and drag the cursor in the
direction of the reaction.

If there are structures present in the Structure Drawing window, roles
are automatically assigned to them depending on their spatial
relationship to the arrow.  To redo the automatic role assignment,
draw another arrow; the original arrow is replaced.  To override the
automatic role assignment, use the Reaction Role tool described in
the previous section.

The Reaction Mapping tool allows you to specify reactant/product
atom pairs in reaction structures.  Reactant/product atom pairs are
labeled with the same number, starting with 1.

To specify an atom pair, first draw both the reactant and the product.
Click the Reaction Mapping tool icon.  The cursor changes to
resemble that icon.  Place the cursor tip on the desired reactant node
until it is highlighted and click.  A number appears next to that reactant
node.  Then click the corresponding product node.  The same number
appears next to that product node.

To change or remove an atom pair label, use the Eraser tool and click
the number.  Both occurrences of that number are removed, and all
occurrences of higher numbers drop down by one.

You may create any number of atom pairs.  However, specifying atom
pairs creates a very specific query and may result in a smaller answer
set than one in which pairs are not marked.

The Functional Groups tool allows you to draw reactions that contain
functional group terms.  Functional group terms may be assigned
roles with the Reaction Role tool or Reaction Arrow tool.  For details
about the use of functional group terms, see Exploring Reactions by
Functional Groups in Chapter 6.

Reaction
Mapping Tool

���

Reaction
Arrow Tool

���

Functional
Groups Tool

���
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The Horizontal Tool Palette contains the common atoms and bonds
that are used in structure drawing, along with the molecular formula
and formula weight of the current structure drawing.

The Current Atom box displays the symbol of the current atom,
shortcut, variable, R group, or functional group being used.  This
symbol is inserted when you draw with the Pencil tool.  The default
atom is carbon, C.

You may change the current atom by highlighting or deleting the
current entry and typing another valid atom, shortcut, or variable.  The
Current Atom box is case-insensitive.

If an invalid node symbol is typed, a dialog box is displayed when you
click in the Structure Drawing window or when you press <Enter>.
Click OK.  You are returned to the Structure Drawing window.  Retype
a valid atom, shortcut, or variable or make a selection from the Atom,
Short, or X Menu tool.

To change an existing atom:

1. Place the desired atom in the Current Atom box by using the
Common Atoms Palette (see next page) or Atom, Short, or X
Menu tools, or by typing it into the Current Atom box.

2. Position the tip of the Pencil tool on the node that you want to
change.  It becomes highlighted.  Then click the mouse button to
change it to the item in the Current Atom box.

Horizontal Tool
Palette

Current Atom Box

Current
Atom box Common Atoms Palette

Bonds Palette

Scaling factor
options

Molecular
Formula

Molecular
Weight
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Scaling Factor Box

Molecular Formula/
Formula Weight

Common Atoms
Palette

Bonds Palette

The Common Atoms Palette, to the right of the Current Atom box,
displays the most frequently used atoms.

Click a different atom icon.  This atom now becomes the default and is
displayed in the Current Atom box.

The Bonds Palette represents the bonds that may be used in your
SciFinder Scholar structure drawing.  The bonds include single,
double, triple, and unspecified.  The default is the single bond.

Click a different bond icon.  This bond now becomes the default and is
highlighted.

Use the unspecified bond if you are willing to have any bond value,
i.e., single, double, or triple, retrieved.

To change an existing bond:

1. Click the desired bond from the Bonds Palette.
2. Position the tip of the Pencil tool on the bond that you want to

change.  It becomes highlighted.  Click the mouse button and the
bond changes to the current bond.

The Scaling Factor box indicates the scaling factor for viewing the
structure that you are currently drawing.  100% is the default.

To adjust this factor, highlight the current scaling factor, type a new
scaling factor, and press <Enter>.  Or, click the up or down arrow.
The scaling factor takes affect immediately.

The scaling factor range is from 25% to 400%.

The molecular formula and the formula weight of the current structure
drawing are displayed at the bottom of the Horizontal Tool Palette.



Chapter 4 Exploring by Exact Chemical Structure  4-23

Drawing a
Structure

Follow these steps to build the substance shown here:

1. Click Chemical Substance or Reaction in the Explore window.
Then click Chemical Structure.  An Untitled Structure Drawing
window is displayed.

2. Select the Benzene tool icon from the Vertical Tool Palette.

Place the ring cursor arrowhead just left of the center in your
Structure Drawing window.  This centers your drawing.  Click to
place the benzene ring.

Place the ring cursor arrowhead on the middle of the right-most
vertical bond of the ring.  The bond is highlighted when the cursor
touches it.  Click to fuse another ring.  Two fused benzene rings
are now in the structure window.  Atoms in each ring are carbon.
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You may also fuse the second ring by placing the ring cursor
arrowhead on a node on the right side of the existing ring. Click
and hold your mouse button as you rotate the new ring.  Release
your mouse button when the two rings are fused.

3. Click the Chain tool icon.

Place the chain arrowhead on the upper right node of the right-
most ring.  The node is highlighted when your arrowhead touches
it.  Click and drag the cursor away from the ring until you see a
chain length of 1.  Release the mouse button.  A chain of one
carbon atom is attached by a single bond to the ring.

Then place the chain arrowhead on the lower right node of the
right-most ring.  Press and hold the <Shift> key as you click and
drag the chain tool cursor away from the ring until you have drawn
a chain length of 2.  Pressing the <Shift> key while placing a
chain reverses its orientation.
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4. Click the double bond icon from the Horizontal Tool Palette.
The cursor automatically changes to the Pencil tool.

Place the pencil tip on the middle node of the 2-atom chain.
Press and hold the mouse button as you drag the pencil straight
down until a chain length of 1 is drawn.  Release the mouse
button.  A double bond is drawn between the 2 carbon atoms.

You may also attach a carbon by a single bond to the middle node
of the 2-atom chain using the method described in step 3.  Then
click the double bond icon and place the pencil tip on the single
bond and click.  The bond changes to a double bond.

A third method is to simply draw a second single bond between
the two atoms.  The result will be a double bond.

5. Click the N atom icon (nitrogen atom) on the Horizontal Tool
Palette.  Place the pencil tip on the top carbon in the right-most
ring and click.  The carbon is replaced with a nitrogen atom.
Repeat the process for the bottom carbon in the same ring.

Click the O atom icon (oxygen atom) on the Horizontal Tool
Palette.  Place the pencil tip on the bottom node of the double
bonded chain and click.  The carbon is replaced with an oxygen
atom.

6. Click in the Current Atom box and highlight or delete the current
atom (it should be oxygen, O).  Type the symbol for methyl, Me.
Me becomes the new atom default.  Position the pencil tip on the
top, right-most node of the 1-atom chain and click.  The carbon is
replaced with Me.

You may also select the Me shortcut by clicking the Short Menu
tool on the Vertical Tool Palette.  Refer to the Short Menu Tool
section earlier in this chapter for details.
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Structures drawn in SciFinder Scholar may be saved for later use in
SciFinder Scholar or other applications.  For details about saving
structure drawings and exporting structures to other applications, see
Appendix B, Importing and Exporting Structure Queries.

If you wish to retrieve substance answers that contain particular
structure fragments or multiple components, draw a query that
contains one or more structures that are not connected to each other.
When you click Get Substances (see the following section for
details), SciFinder Scholar will alert you that there are multiple
fragments in your query and ask if you would like to continue.
Click OK.

Saving and Reusing
Structures

Searching for Multiple
Fragments or
Components
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When you have completed a chemical structure drawing, you are
ready to perform a structure search.  Structure searches may be
performed on structures drawn in SciFinder Scholar or structures
opened from files in other formats.  For information on importing a
structure from another application, see Appendix B, Importing and
Exporting Structure Queries.

Click Get Substances to initiate a search.  If you have the SciFinder
Substructure Module (SSM), the Get Substances dialog box is
displayed.

SSM users may choose either:

• an exact match or a related structure
• a substructure of a more complex structure (see Chapter 5)

For this example, select an exact match or a related structure.
Exact structure searching allows you to retrieve one or more substance
candidates.  These may include:

• The structure exactly as you have drawn it
• Stereoisomers
• Tautomers (including keto-enol)
• Coordination compounds
• Charged compounds
• Radicals or radical ions
• Isotopes
• Polymers in which the structure is a monomer

To exclude particular types of substance answers, click Additional
Options and modify the settings.  Or, modify the settings in the
Explore tab of the Preference Editor.  See Appendix A, Preferences,
for details.

Click OK to submit your structure query.

Performing
an Exact
Structure
Search
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SciFinder Scholar uses a CAS intelligent searching process, called
Smartsearch, to provide maximum recall for your “exact match”
structure query.  For more information on Smartsearch, see Appendix
C, Smartsearch: Inside Explore by Chemical Structure.

While SciFinder Scholar is searching, a Stop sign appears in the
bottom right corner.  It allows you to cancel the search, if needed.  If
you allow the search to go to completion and substances are found,
they are displayed in the SciFinder Scholar window.

Your query structure is highlighted in each structure in the answer set.
Results are displayed in the default format and order.  To change the
display, select from options in the View menu.  Or, change the defaults
in the Display tab of the Preference Editor.  See Appendix A,
Preferences, for details.
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To view substance details, click the microscope icon next to the
substance.  A Detail of Substance # dialog box is displayed.  A
substance record may include the CAS Registry Number, chemical
names, molecular formula, the chemical structure, and other related
information.

Details are displayed in the default format for this window, specified in
the Display tab of the Preference Editor.  See Appendix A,
Preferences, for details..

The STN Files list identifies databases and inventories that contain
additional information for this CAS Registry Number.  Contact your
Site Administrator to find out how you can access and use these STN
files and inventories to locate more information on a CAS Registry
Number.

You may print or save the record by selecting Print or Save As from
the File menu.  See Chapter 2 for details.

To return to the SciFinder Scholar window, click Close.

Viewing Substance
Details
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Retrieving
References for
Substances

Use the Keep Substances option to retain only the substances that
interest you.  Click the boxes next to the substances you would like to
keep.  Then select Keep Substances from the Tools menu.
SciFinder Scholar displays only the substances that you selected.

Substance answer sets may be refined by chemical structure and/or
commercial availability.  They may also be analyzed by precision and
by ring skeletons, atoms, and bonds.  Additional analysis options are
available for substructure answer sets.  Descriptions of the Refine
Substances and Analyze Substances features are provided in
Chapter 5.

To retrieve references that cite a substance or group of substances,
click Get References.  You may optionally select substances of
interested before clicking Get References.  The Get References
dialog box is displayed.

Choose to retrieve references for all substances or only those you
selected in the previous screen.  You may then opt to minimize the
number of references retrieved by selecting specific substance types
under For each substance, retrieve.  Click the radio button next to
Only the following types.  Then select the substance types of
interest, e.g., Preparation.  Click OK.

Refining and
Analyzing
Substances

Keeping Substances
of Interest
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The references for the substances you selected are displayed in the
SciFinder Scholar window.

References are displayed in the default format and order.  See Chapter
7 for details on working with references.  For saving and printing
instructions, see Chapter 2.

To begin a new task, click the New Task button on the Main Menu
Toolbar or select New Task from the File menu.

To exit SciFinder Scholar, select Exit from the Main Menu Toolbar or
select Exit SciFinder Scholar from the File menu.

Ending Your
Explore Session
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5 Exploring by Substructure

SciFinder Scholar’s substructure searching feature allows you to draw
a chemical structure (see Chapter 4) and retrieve answers that may
include:

• Exact structure search results, plus
• Matches in which the query structure is a part of a more complex

structure, which may have substitution at positions left “open” in the
query

• Matches where your query structure is embedded in a larger ring
system

Chapter 5 expands on Chapter 4 and includes the following topics:

• Applying substructure-specific tools
• Previewing your results
• Performing a substructure search
• Refining and analyzing your results

���
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Substructure searches often retrieve large substance answer sets
because the search requirements are quite general.  Details on the
types of substance answers you can expect from your substructure
search are given in Appendix C, Smartsearch: Inside Explore by
Chemical Structure.

These answers may also provide information concerning:

• Preparation methods
• Commercial sources and regulatory information
• Bibliographic references and abstracts

Substructure searching capabilities include:

• Executing substructure searching capabilities for structures drawn in
SciFinder Scholar’s Explore by Chemical Structure

• Isolating rings from further ring fusion or allowing rings to be
embedded in other ring systems.

• Allowing a chain to be in a ring or chain in answers or to be
chain only

• Opening and closing sites for substitution in rings and chains
• Defining R groups, multiple allowable substituents at a position, to

include atoms, shortcuts, and variables with up to 10 R groups per
structure

• Using predefined variables, i.e., generic nodes
• Importing and exporting queries with substructure attributes
• Accessing all SciFinder Scholar tools, features, and tasks

A Preview feature is provided that allows you to view or analyze sample
answers prior to actually performing the search.  This will assist you in
drawing a query that will be searched successfully and in a reasonable
time frame, while allowing you to retrieve a manageable number of
relevant answers.  Preview also can provide insight into the potential
structure answers you may retrieve.

Once you have completed a substructure search, the Analyze feature
allows you to categorize and evaluate your answer set in several ways.
These features are discussed later in this chapter.

Introduction to
Substructure
Searching
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To Explore by substructure, open a Structure Drawing window by
clicking Explore in the New Task window.  Then click Chemical
Substance or Reaction.  Finally, click Chemical Structure.  An
Untitled Structure Drawing window is displayed.

Accessing
Explore by
Substructure

Preview
command in
File menu

X Menu
(Variables)

tool

(Un)Lock All Positions
command in Tools menu

Lock Out Rings tool

R Group tool

Lock Out
Substitution

tool

Preview
button
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Substructure
Drawing
Features

The Structure Drawing window includes tools for drawing structure
queries as well as tools, menu items, and buttons that are used
specifically for substructure searching.  These items, which are
indicated on the previous page, include:

• Lock Out Substitution tool – prohibits additional substitution at
designated nodes

• Lock Out Rings tool – prohibits additional ring fusion and sets chain
bonds to chain only

• Unlock All Positions in the Tools menu – allows substitution at all
nodes

• Lock All Positions in the Tools menu – inhibits substitution at all
nodes

• X Menu tool – allows variable groups to be placed in your structure
• R Group tool – opens the R Group Definition dialog box where you

may create up to 10 R groups, i.e., define multiple substituents
allowed at a position

• Preview in the File menu and Preview button near the bottom of
the window – allows you to analyze your query and retrieve a set of
sample answers

The following table identifies the defaults that SciFinder Scholar
assumes.

Substructure Drawing
Defaults

If your
substructure
contains:

SciFinder Scholar finds structure matches
where:

Rings

The skeleton ring system you drew is:
- Exactly as you drew it
- Further substituted
- Embedded within a larger ring system

Chains

The nodes in the chain are:
- Further substituted
- Part of a Ring
- Part of a Chain

The bonds in the chain are part of a:
- Chain
- Ring

Terminal
Shortcuts from
the Short Menu,
with the exception
of Ak

The terminal shortcut is locked from substitution
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You may change the substructure drawing defaults by using the
SciFinder Scholar drawing tools described in the following table.

To perform a substructure search, first draw a structure you would like
to search.  For this example, draw the following structure in your
Structure Drawing window:

Details about drawing structures are provided in the Drawing a Structure
section of Chapter 4.  Drawing tools are also described individually in
Chapter 4.

Changing
Substructure Drawing
Defaults

Drawing a
Substructure

R1 = C, O, N, S, H

If the
substructure
contains:

Use this SciFinder Scholar tool:

Ring System Lock Out Rings tool to isolate the ring system.  No
further fusion, including spiro, is allowed on the drawn
ring system.

Chain Bonds Lock Out Rings tool to set bonds to chain only.  Node
default cannot be reset.

Ring or Chain
Nodes

Lock Out Substitution or Lock All Positions in the
Tools menu command to prevent further substitution.



5-6  Chapter 5 Exploring by Substructure

1. Use the Benzene tool to place a benzene ring in the center of the
Structure Drawing window.

2. Click the Short Menu tool, and hold down the mouse button to
display the menu.  Select Me.  Use the Pencil tool to attach Me
to the ring by a single bond.

3. Click the X Menu tool and hold down the mouse button to display
the menu.  Select X Any halogen.  Use the Pencil tool to attach
X to the ring by a single bond.

4. Click the N in the Common Atoms Palette.  Click the Pencil tool
to attach N to the ring by a single bond.

5. Use the Chain tool to draw a 5-membered chain attached to the N.

6. Click the Short Menu tool and hold the mouse button to display
the menu.  Select Me.  Place your cursor over the node at the end
of the chain.  Click to replace the carbon atom with Me.

7. Click the R Group tool.  In the R1 = box, type C, O, N, S, H.  Use
the Pencil tool to attach R1 to the chain by a single bond.

8. Click O on the Common Atoms Palette.  Click the double bond
on the Common Bonds Palette.  Use the Pencil tool to attach O
to the chain by a double bond.

9. Click the Lock Out Substitution tool.  Place your cursor over the
N to highlight it and click.  This isolates the N from further
substitution.

10. Click the Lock Out Rings tool.  Place your cursor over a bond in
the ring to highlight the ring and click.  This isolates the ring from
further ring fusion.

Place your cursor over any bond in the chain to highlight the chain
and click.  This sets the chain bonds to chain only.
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When you have completed the drawing, your Structure Drawing window
should look similar to this:

Alternatively, you may open a previously saved structure file by
selecting Open from the File menu or by pasting a structure into the
Structure Drawing window from the clipboard.  See Appendix B,
Importing and Exporting Structure Queries, for more information.
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The Preview feature gives an estimate of the number of answers you
can expect and shows some sample answers.  With Preview, you can
analyze sample answers to predict whether your substance query will
retrieve answers and what kind of answers you will retrieve.

After your structure is complete, click the Preview button.  The
Preview dialog box is displayed.

You can Preview by:

• Answers – allows you to view representative answers
• Real-atom attachments – allows you to get estimates of the types

of attachments you can expect at real atoms on the structure
• Variable group composition – allows you to get frequency of

occurrence estimates of the atoms at each variable site
A – any atom except H
Q – any atom except C or H
X – any halogen
M – any metal

• R-group composition – allows you to get frequency of occurrence
estimates of the atoms at each R group site

Each Preview option also gives you an estimate of the total number of
answers this structure will retrieve via Get Substances.

If a large number of potential answers are identified, an alert message
is displayed.  The AutoFix feature may help narrow your query.
Clicking the Autofix button locks out all rings and chains, as if you
had applied the Lock Out Rings tool.  This prohibits fusion to the ring
and sets all chain bonds to chain only.  You are returned to the
Structure Drawing window, and all of the rings and chains in your
structure appear in bold.  Click Preview to try again.

Previewing
Substructures

Preview Not
Completed
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To preview a sample of answers, click the radio button next to
Answers in the Preview dialog box.  Then click OK.  The Preview
Answers window is displayed.  It contains a set of sample answers
and an estimate of the total number of answers Get Substances will
find.

To view a structure at a larger size, click the magnifying glass icon
next to the structure.  A Detail of Substance #  window is displayed.

Previewing Answers
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Click Close to return to the Preview Answers window.  Then click
Back to return to the Preview dialog box to choose another Preview
option.

To preview real-atom attachments, click the radio button next to Real-
atom attachments in the Preview dialog box.  Then click OK.  The
Preview Real-atom Attachments window is displayed.

Click an atom in the structure to get an estimate of the attachments
you can expect at that node in your Get Substances answer set.  The
node you click is labeled with a bond to a question mark.  The preview
information for that node is displayed in the Atom attachments box to
the right.  Definite substitutions appear in black, and variable
substitutions, e.g., A, appear in blue.  The total number of answers is
the sum of the definite substitutions.  The variable substitution answers
are also represented by definite substitution answers.

You may click a check mark in one or more boxes under Atom
attachments to include those nodes in your query.  Then click Modify
Structure.  The structure in your Structure Drawing window will be
modified to reflect this change.

Or, click Back to return to the Preview dialog box to choose another
Preview option.

Previewing
Real-Atom
Attachments
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To preview variable group composition, click the radio button next to
Variable group (A, Q, X, and M) composition in the Preview dialog
box.  Then click OK.  The Preview Variable Group (A, Q, X, and M)
Composition window is displayed.

Click a variable, e.g., X, to highlight it.  The Preview information for that
variable is displayed in the Variable Group Composition box to the
right.

You may click a check mark in one or more boxes under Variable
Group Composition replace the variable with the selected nodes.
Then click Modify Structure.  The structure in your Structure Drawing
window will be modified to reflect this change.

Or, click Back to return to the Preview dialog box to choose another
Preview option.

Previewing Variable
Group Composition
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To preview by R-group composition, click the radio button next to
R-group composition in the Preview dialog box.  Then click OK.
The Preview R-group Composition window is displayed.  Click an R
group, e.g., R1, to highlight it.  The Preview information for that R group
is displayed in the R-group Composition box to the right.

You may click a check mark in one or more boxes under R-group
Composition to narrow your query to only those structures.  Then
click Modify Structure.  The structure in your Structure Drawing
window will be modified to reflect this change.

Or, click Back to return to the Preview dialog box.

When you are satisfied with your query, click Cancel in the Preview
dialog box to return to the Structure Drawing window.

Previewing R-group
Composition
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When you are satisfied with your search structure, click Get
Substances in the Structure Drawing window to perform the search.
The Get Substances dialog box is displayed.

To modify your Explore options for the current search only, click the
Additional Options button.

The options are the same as those found in the Explore tab of the
Preference Editor.  Select the substance types to include or exclude
from your search.  For details about Explore options or changing your
Explore Preferences, see Appendix A, Preferences.

To submit a substructure search, click the radio button next to a
substructure of a more complex structure.  Then click OK.

Performing a
Substructure
Search
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SciFinder Scholar conducts the search and displays the answers in the
SciFinder Scholar window.

Your query structure is highlighted within the structures in the answer
set.  This helps you more readily identify where your structure is
contained in the answer structures and perhaps why particular answers
were retrieved.

Results are displayed in the default format and order.  To change the
display, select from options in the View menu.  Or, change the defaults
in the Display tab of the Preference Editor.  See Appendix A,
Preferences, for details.

You may view the structures with the microscope icon, select and
keep specific answers, Get References, and Refine Substances, just
as you would for an exact structure search.  See the corresponding
sections on these topics in Chapter 4.  For saving and printing
instructions, see Chapter 2.
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If a large number of potential answers are identified, an alert is
displayed.

The AutoFix feature and Additional Options may help narrow your
query.

Click the AutoFix button to lock out all rings and chains, as if you had
applied the Lock Out Rings tool.  This prohibits fusion to the ring and
sets all chain bonds to chain only.  You are returned to the Structure
Drawing window, and all of the rings and chains in your structure
appear in bold.  Click Get Substances to try the search again.

Get Substances Not
Completed
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Alternatively, click Additional Options to modify your Explore options
for current search only.

The options are similar to those found in the Explore tab of the
Preference Editor.  Select the substance types to include or exclude
from your search.  For details about Explore options or changing your
Explore Preferences, see Appendix A, Preferences.

The Limit by Formula Weight option allows you to narrow your query
to substances in a particular formula weight range.  This option is only
available for single-component structure queries.  The Min box is
prefilled by SciFinder Scholar with the formula weight of your query,
provided at the bottom right of the Structure Drawing window.  Edit the
Min and Max to reflect the formula weight range of interest.

Multiple-component answers will be retrieved if at least one component
matches the structure query and falls in the formula weight range.

Click OK to try the search again.
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Analyzing
Substances

The Analyze Substances feature is useful for working with large answer
sets obtained by substructure searching.  This feature works similarly
to the Preview feature described earlier in this chapter.

To begin analyzing your answer set, click the Analyze Substances
button in the SciFinder Scholar window.  The Analyze dialog box
appears, displaying the analysis options.

Select an analyze method by clicking the appropriate radio button:

• Real-atom attachments – allows you to determine the types of
attachments present at a particular site

• Variable group (A, Q, X, and M) composition – allows you to
determine the atoms at particular variable sites

• R-group composition – allows you to determine the atoms that
make up particular R groups

• Precision – identifies the types of answers that make up your
answer set, i.e., conventional substructure, closely or loosely
associated tautomers and zwitterions, or other

• Ring Skeletons – divides the answer set on the basis of
substances’ skeletons, atoms, and bonds

You may choose to analyze the full answer set or a subset of the
answers.  To select a subset of answers to analyze, click Cancel to
return to the SciFinder Scholar window.  Then select a subset of
answers by clicking in boxes next to the substances you would like to
analyze.  Click Analyze Substances to redisplay the Analyze dialog
box.  The radio button next to Analyze only selected substances is
selected.

Click OK to begin analyzing.
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To analyze by real-atom attachments, click the radio button next to
Real-atom attachments in the Analyze dialog box.  Then click OK.
The View Real-atom Attachments window is displayed, which shows
your query structure.

Click an atom in the structure to display the types of attachments at
that atom in the answer set structures.  The node you click is labeled
with a bond to a question mark, and the results are displayed in the
Atom attachments box to the right.  Definite substitutions appear in
black, and variable substitutions, e.g., A, appear in blue.  The total
number of answers is the sum of the definite substitutions.  The
variable substitution answers are also represented by definite
substitution answers.

You may click a check mark in one or more of the boxes under Atom
attachments to narrow your answer set to only those structures that
have the specified attachments.  Click Get Substances to create the
smaller answer set.

Or, click Back to return to the Analyze dialog box to choose another
Analyze option.

Analyzing by
Real-Atom
Attachments
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To analyze by variable group, click the radio button next to Variable
group (A, Q, X, and M) composition in the Analyze dialog box.
Then click OK.  The View Variable Group (A, Q, X, and M)
Composition window is displayed.

Click a variable, e.g., X, to highlight it.  The composition at that variable
in the answer set is displayed in the Variable Group Composition
box to the right.

You may click a check mark in one or more of the boxes under
Variable Group Composition to narrow your answer set to only those
structures that have the specified composition attached at this
position.  Click Get Substances to create the smaller answer set.

Or, click Back to return to the Analyze dialog box to choose another
Analyze option.

Analyzing by Variable
Group Composition
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To analyze by R group, click the radio button next to R-group
composition in the Analyze dialog box.  Then click OK.  The View
R-group Composition window is displayed.

Click an R group, e.g., R1, to highlight it.  The composition of that R
group in your answer set is displayed in the R-group Composition
box to the right.

You may click a check mark in one or more boxes under R-group
Composition to narrow your answer set to only those structures that
have the specified atom at this position.  Click Get Substances to
create the smaller answer set.

Or, click Back to return to the Analyze dialog box to choose another
Analyze option.

Analyzing by R-group
Composition
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Analyze by Precision allows you to see the types of answers that
make up your answer set.

To analyze by precision, select the radio button next to Precision in
the Analyze window and click OK.  The Precision Analysis window is
displayed, showing the makeup of the answer set.

The answers are divided into four categories:

• Conventional Substructure
• Closely Associated Tautomers and Zwitterions
• Loosely Associated Tautomers and Zwitterions
• Other

You may click a check mark in one or more boxes in the Precision
Analysis window to narrow your answer set to only those answers in a
particular category.  Click Get Substances to create the smaller
answer set.

Or, click Back to return to the Analyze dialog box to choose another
Analyze option.

Analyzing by
Precision
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Analyze by Rings divides a substance answer set into subsets, or
buckets, of substances that contain rings with similar skeletons,
atoms, or bonds.  Each bucket shows a ring for which there is at least
one atom from the query structure.  These rings are referred to as
“matched rings.”  The number of substances in the answer set that
contain the matched ring is indicated.

Answer sets may be analyzed on the basis of:

• Ring skeleton only
• Ring skeleton and atoms contained in the rings
• Ring skeleton, atoms contained in the rings, and bonds involved

For this example, build the following structure in a Structure Drawing
window:

1. Begin by drawing the ring skeleton.  Click the Benzene tool icon
on the Vertical Tool Palette.  Place the cursor in the Structure
Drawing window, and click to draw a benzene ring.

Click the Cyclopentadiene tool icon.  Position your cursor over
the rightmost bond of the benzene ring.  Click to draw a
cyclopentadiene ring fused to the benzene.

Click the Benzene tool icon again.  Position your cursor over the
bottom right bond of the ring system already drawn in the Structure
Drawing window.  Click to fuse a benzene ring to the ring system.

2. Click and hold the X Menu (Variables) tool icon to display the
variables menu. Select X Any halogen.  Add an X substituent to
the ring skeleton as shown above.

3. Click the R Group tool icon to display the R Group Definitions
box.  Replace a carbon in the ring system with R1 as shown
above.  In the R Group Definitions box, define R1 as C or N.

Analyzing by Ring
Skeletons

R = C, N



Exploring by Substructure  5-23Chapter 5

Searching the substructure as shown above will retrieve structures
where additional rings may be fused to the ring skeleton.  In addition,
substituents may appear at any open site.  Ring fusion and additional
substitution may optionally be blocked with use of the Lock Out Rings
Tool and Lock Out Substitution Tool.

To retrieve substances that contain your substructure query, click Get
Substances.  Select a substructure of a more complex structure.
Then click OK.  SciFinder Scholar conducts the search and displays
the answers in the SciFinder Scholar window.
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Your query structure is highlighted within the structures in your answer
set.  Analyzing by Rings will divide the answer set into groups of
substances that contain rings with similar skeletons, atoms, or bonds.

Click Analyze or Refine Substances.  Then click Analyze.  To
analyze only a portion of the answer set, select boxes next to
substances of interest before clicking Analyze Substances.  The
Analyze dialog box is displayed.  Select Ring Skeletons, and choose
whether to analyze all answers or only those selected.  Click OK.
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The Ring Analyze dialog box is displayed.

Select an option in the Ring Analyze dialog box.  Then click OK.
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Analyzing by Ring Skeleton Only divides the answer set on the basis of
ring framework without regard to the atoms or bonds involved.  In the
Ring Analyze dialog box, select Ring skeleton only.  Then click OK.
Buckets are displayed for all ring skeletons in the substance answer set
that contain at least one atom from the query structure.

Analyzing by Ring
Skeleton Only
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Buckets containing the most substances from the answer set are
displayed first.  The number of substances and a ring image are given.
In some rare instances, an image for a matched ring cannot be
generated.  In this event, a “no ring image available” message is
displayed instead of the ring image.

One or more additional buckets may appear after the matched ring
buckets:

• Rings Not Matched – substances in the answer set that contain
rings, but none of the rings contain at least one atom from the query
structure

• No Rings – substances that do not contain any rings
• Other – substances for which ring analysis could not be completed

Because a substance answer may contain more than one matched ring,
individual answers may appear in more than one ring bucket.  Thus, the
buckets are not mutually exclusive.

If you are interested in only answers in particular buckets, click the
appropriate check boxes.  Then click Get Substances to view only the
substances of interest.

When you have finished viewing the answer set, click Back to return to
the Ring Analyze options.
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Analyzing by Ring Skeleton with Atoms divides the answers set into
groups of substances that contain the same ring skeleton and specific
atoms within that skeleton.  In the Ring Analyze dialog box, choose
Ring skeleton with atoms.  Then click OK.  Buckets are displayed
for ring skeletons that have atoms in the same positions as a ring
system in the query structure.

You may select buckets of interest and click Get Substances.  Or,
click Back to return to the Ring Analyze options.

Analyzing by Ring
Skeleton with Atoms
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Analyzing by Ring Skeleton with Atoms and Bonds divides the answers
set into groups of substances that contain the same ring skeleton and
specific atoms and bonds within that skeleton.  In the Ring Analyze
dialog box, choose Ring skeleton with atoms and bonds.  Click OK.
Buckets are displayed for ring skeletons that have atoms and bonds in
the same positions as a ring system in the query structure.

You may select buckets of interest and click Get Substances.  Or,
click Back to return to the Ring Analyze options.  Click Back again to
return to the original answer set.

To leave your substructure session, select New Task from the File

Analyzing by Ring
Skeleton with Atoms and
Bonds
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If you get a large number of substances with your search, the Refine
Substances feature may help reduce the size of your answer set.  This
feature allows you to add additional search criteria to your original
search strategy.

Click Refine or Analyze Substances.  Then click Refine to display
the Refine by Chemical Substance options.

Refine Substances allows you to narrow your answer set by Chemical
Structure, Commercial Availability, or Property Data (for SSM
users only).

Click Chemical Structure to return to the Structure Drawing window.
You may make your query more precise by modifying your original
structure or by adding a fragment that must be present. After editing
the structure, click Get Substances.  SciFinder Scholar creates a new
substance list with your new structure requirements.

If there is a chemical moiety that you want to require in your answers,
e.g., a carboxyl group, but you do not have any particular site where
you want it to be attached, delete the original structure and draw that
moiety alone.  Get Substances will then do a subset search on your
original answer set.

Click Commercial Availability if you are only interested in
substances that are commercially available. SciFinder Scholar returns
only the substances from your answer set that have Commercial
Availability information.

Refining
Substances

Refine by Chemical
Structure

Refine by Commercial
Availability
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SSM users may click Properties to refine the answer set by physical
properties.  The Refine by Property dialog is displayed.

Select the properties you wish to include in your refinement, and
indicate the appropriate values for those properties.  When multiple
properties are selected, results must meet all of the selected property
conditions.

Include substances with no value for the specified properties
ensures that substances without values available for selected
properties are retained in your answer set.  Deselect this option if you
do not wish to retain those substances.

Refine by Property
Data
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Ending Your
Explore Session

The first four properties are preselected and prefilled with parameters
developed by Christopher A. Lipinski and colleagues at Pfizer Central
Research, Groton, CT.  Refining by these parameters is helpful in
identifying potential drug candidates.  These parameters are the initial
default values for Refine by Property, found on the Analyze tab of the
Preference Editor.

To change your defaults, click the Change Preferences button.  If you
do not change your defaults, the property selections are kept only for
the current search.

The Preference Editor opens to the Analyze tab (see Appendix A for
details).  The Refine by Property section displays the selections you
chose in the Refine by Property dialog box.  You may make
additional changes to the Preferences.  Click OK to save the new
defaults and return to your search.

Once you have made your selections, click OK to refine your answer
set.

To leave your substructure session, select New Task from the File
menu or click the New Task icon on the Main Menu Toolbar.

To exit SciFinder, select Exit SciFinder from the File menu or click
Exit on the Main Menu Toolbar.
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8 Linking to Additional
Information

SciFinder Scholar provides many opportunities to link among sources
to obtain additional information about substances or references.  For
example, you may link from reference records to substance records,
and from substance records to regulated chemicals information.

Chapter 8 acquaints you with linking options available in SciFinder
Scholar.  Convenient links are provided to:

• Substance records in the CAS REGISTRY database
• Commercial sources
• Regulatory information
• Individual cited references
• 3D structure models (with WebLab® ViewerTM)
• Related information on the Web via eScience®

• Full-text documents (via ChemPortSM)

Additionally, you can link to SciFinder Scholar from an e-article (at
several publisher web sites) and explore for information related to that
article.  Links discussed in this chapter are outlined in the chart below.

Links to Additional Information

Cited
References

Full Text via
ChemPort

Reference
Record

Substance
Record

Commercial
Sources

Regulatory
Information

3D Structure
Models

Related
Information via

eScience
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CAS Registry Numbers are included in many detailed references.

Click the CAS Registry Number hypertext link to view details about
the corresponding substance.

Linking to
Substance
Records

hypertext link
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A Detail for Registry Number # dialog box is displayed.

The full substance record may include the CAS Registry Number,
chemicals names, molecular formula, chemical structure, and other
related information.

The STN Files list identifies databases and inventories that contain
additional information for this CAS Registry Number.  Contact your site
administrator or the CAS Help Desk to find out how you can access
and use these STN files and inventories to locate more information on a
CAS Registry Number.

You may print or save the record by selecting Print or Save As from
the File menu.

To return to the previous window, click Close.
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While displaying a reaction obtained via a reaction search, you may
view the substance record for any substance participating in the
reaction.

To view a substance record, click a reactant, reagent, product, or
catalyst.  A Detail for Registry Number # dialog box is displayed and
may include the CAS Registry Number, CA Index Name, formula, and
more.  For details and to view examples, refer to the Viewing
Substance Records within a Reaction section in Chapter 5.

Over 3,300,000 products accessed via SciFinder Scholar are linked to
information concerning their commercial availability.  This information is
from more than 700 chemical catalogs and libraries.

Commercial Sources links, when available, are found in substance
records.

To retrieve chemical supplier information for substances, click the
Commercial Sources link.

Linking to Substance
Records from
Reactions

Linking to
Commercial
Sources

hypertext
links
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The Sources for # dialog box is displayed.

Chemical supplier information may include the catalog name,
quantities available, publication date of the catalog, order number,
chemical names, synonyms, and CAS Registry Number.

To ensure that this data is current, contact the supplier.

The check boxes at the left allow you to save or print a subset of the
sources.  To do so, click one or more boxes.  Select Save As or Print
from the File menu.

You may obtain further information for the source by clicking the
microscope icon that follows each commercial source.  This displays
the Detail of Source # dialog box.
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This information includes more in-depth data including company
information, quantity, pricing, and structure diagrams.  Company
information includes the names, addresses, and phone numbers of
distributors.  The CAS Registry Number for the substance is
highlighted.

To print or save detailed source information, select Print or Save As
from the File menu.  To exit the detailed source information, click
Close.  You are returned to the Sources for # dialog box.

Regulatory information can be accessed via Regulated Chemicals
Listing links.  This information may contain a list of worldwide
inventories, including the U.S., Australia, Japan, Korea, Canada (DSL
& NDSL), and European (ELINCS & EINECS) inventories, in which
the substance appears.

Linking to
Regulated
Chemicals
Listing
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Regulated Chemicals Listing links, when available, are found in
substance records.  See the previous section, Linking to Commercial
Sources, for an example.

To retrieve the list of inventories for a substance, click the Regulated
Chemicals Listing link.  The Regulated Chemicals Listing for #
dialog box is displayed.

Regulatory chemicals listings may include the CAS Registry Number;
chemical names; the inventory (File Segment), using the name,
countries, and inventories citing the substance; confidentiality status;
Regulatory List Numbers; inventory status; and more.

To print or save a regulated chemical listing, select Print or Save As
from the File menu.  To exit this window, click Close.  You are
returned to the previous window.
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Linking to Cited
References

For over 965,000 records added to the CAS databases from 1999 to the
present, a list of cited references, or citations, appears in the Full
display.  If Full is the display format selected for the References Viewer
in the Display tab of your Preference Editor, simply click the
microscope icon for the document.  Or, select Full from the View
menu for documents displayed in the main SciFinder Scholar window.
You may need to scroll down to view the citations.

From the Citations portion of the record, you may link to the CAplus or
MEDLINE record being cited.  Click a linked citation to view the
detailed record.  The record displays in the Detail for Citation #
window.  If both a CAplus and MEDLINE record are associated with
the link, the CAplus record is displayed.
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The e-document icon is displayed in the top right corner of the Detail
for Citation # window for documents that are available electronically
via ChemPort.  Click the icon to view options for electronic access.
See Accessing Full-Text Documents later in this chapter for details.

The Detail for Citation # window can be left open for viewing several
citations consecutively.  Use the Previous and Next buttons to move
among citations you have already displayed.  Citations are
redisplayed based on the order the links were clicked.  For example, if
you click citations in the order 1, 9, 4, 7, they are redisplayed with the
Previous button in the order 7, 4, 9, 1.

To retrieve related information, click the Get Related button.  For
details, see Chapter 7 and Linking to eScience later in this chapter.

To print or save a cited reference, select Print or Save As from the
File menu.  To exit this window, click Close.
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Linking to 3D
Structure
Models
(Windows only)

Installing WebLab
ViewerLite

Windows users may use WebLab ViewerLite or ViewerPro software
along with SciFinder Scholar to view 3D structure models.  The
WebLab Viewer products are high-end molecular visualization
applications that use Open GL graphics for visualizing models of
molecules.  Models can be rotated, scaled, edited, labeled, and
analyzed to provide better understanding of 3D structure.

WebLab ViewerPro is available for purchase from Accelrys (visit
http://www.accelrys.com/about/msi.html for details).  WebLab
ViewerLite is available via free download from the Accelrys web site.
SciFinder Scholar accesses the version of WebLab Viewer that was
most recently installed on your PC.

Close all Windows applications and anti-virus software, except your
Internet browser.  Installation may not proceed properly if other
programs are running.

1. Open your Internet browser to:

http://www.accelrys.com/viewer/register/lite/viewerlite_reg.php

2. After reading the license agreement, enter the appropriate
information.  Then click the Submit Form button at the bottom of
the page.

3. Click the WLViewerLite40.exe link to download the software.
The Save As window displays.  Choose a folder.  Click Save to
download the file to your computer.

4. Open the folder you chose in step 3.  Double-click the
WLViewerLite40.exe icon.  A WinZip Self-Extractor window
displays.  Click Setup to begin the installation, and follow the
prompts.
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Once you have properly installed the WebLab Viewer, 3D Model links
are displayed for many of the substances in SciFinder Scholar.

Click the 3D Model link to display the 3D model for that structure.

Use the menu items to manipulate the display and to save or print the
file.  The Help menu provides explanations of the functions available.
For more information on the features of WebLab Viewer, visit the
Accelrys web site at http://www.accelrys.com/weblab/index.html.

Viewing 3D Models
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eScience is a dynamic web resource from CAS.  After viewing your
SciFinder Scholar results, you can quickly and easily extend your
search to the Web via the GoogleTM, ChemIndustry.com, or ChemGuide
search engine. eScience also provides convenient links to respected
news services, science-related portals, and electronic publications.
For more information about eScience, visit http://www.escience.org.

eScience can be accessed from any answer set created with Explore
by Reseach Topic, Author Name, or Company Name/Organization.
First, create a reference answer set with one of these Explore features.

Click the Get Related button.  Then click eScience.  Your web
browser is launched, and the eScience web page is displayed.

Linking to
eScience®
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The search box is prefilled with the search terms from your SciFinder
Scholar Explore.  You may edit these terms as appropriate.  To search
the Web, select the ChemIndustry.com or Google search engine.  Then
click Go.

Note: When answer sets are created with Explore by Author Name,
SciFinder Scholar prefills the search box with all variations of author
names selected in the Author Candidates dialog.  If you receive a
message that the search string is too long, shorten the string and try
the search again.
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Your results are displayed by eScience.
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Use SciFinder Scholar to access full text of articles and patents via
your Internet browser and the ChemPort Connection.  ChemPort offers
several options for retrieving full documents for references of interest,
some with no additional charge and some with additional charges.

Full-text options provided at no additional charge:

• View e-articles at publisher web sites (requires a separate
subscription with journal publisher).  Lists of participating publishers
and journals are available at http://www.chemport.org.

• View e-articles using subscriptions with a third-party agent, e.g., a
subscription agent (requires a subscription to the agent’s service).

• Direct document requests to your in-house library system (requires
separate setup; for details, see
http://www.chemport.org/html/english/inhouse.html).

• View patents at the USPTO and EPO web sites and via MicroPatent
(restricted to MicroPatent Global TOPS subscribers).

Full-text options with additional fees:

• Buy electronic articles and patents
• Order paper copies via a document delivery service

In the SciFinder Scholar window, e-document icons are placed to
the right of individual articles or patents from sources that have
electronic full text available via ChemPort.  The e-document icon
appears just below the microscope icon.  Documents from sources
that do not have electronic full text available do not have this icon.  An
e-document icon also appears in the top right corner of the Detail of
Reference # window for documents available via ChemPort.

If your Site Administrator has worked with CAS to set up a list of your
library journal holdings, a house icon will appear in the place of the
e-document icon for journals on your in-house list.  House icons work
similarly to e-document icons.  However, they help you quickly
identify documents that are available via internal sources.

To access a single document, click the e-document icon for the
document, if present.  Or, click the check box to the left of the
document.  Then click the Full Text icon on the Main Menu Toolbar
or select Full Text Options from the File menu.

Your Internet browser opens, and ChemPort retrieves information on
the document you selected.  You are then given options for accessing
the document.  Options that are grayed out are not available for the
document you have selected.  Help for these options is available at
http://chemport.cas.org/html/english/fts_help.html.

Accessing
Full-Text
Documents

Accessing Single
Documents
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To access more than one document, click the check boxes to the left
of those documents.  Then click the Full Text icon on the Main Menu
Toolbar or select Full Text Options from the File menu.

Your Internet browser opens to the Full-text Options page, and
ChemPort retrieves information on the documents you selected.

Titles of the documents are listed on the ChemPort page.  To display
all of the full-text options for an individual document, click the full-text
icon to the right of the title.  Options that are grayed out are not
available for the document you have selected.  Help for these options is
available at http://chemport.cas.org/html/english/fts_help.html.

When you are finished viewing the full-text options, select Close or
Exit from the Internet browser’s File menu to return to SciFinder
Scholar.

Accessing Multiple
Documents
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Linking from
e-Articles to
SciFinder
Scholar

Through ChemPort Reference Linking, several publishers provide links
from cited references within e-articles to SciFinder Scholar.  In
SciFinder Scholar, you to easily explore for information related to the
reference of interest.

Publishers currently participating include:

• ACS Publications
• International Union of Crystallography
• Institute of Physics
• Academic Press
• CatchWord (STM Journal Host)

Links to ChemPort appear with references that have records in CAS
databases.  Links to Medline and ACS Publications full text may also
appear.

Click the [ChemPort] link for a reference of interest.
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The CAS record for the reference is displayed by ChemPort.

To search for information related to this reference, click Explore with
SciFinder Scholar from the blue bar on the left.  You must be logged
on to SciFinder Scholar for this feature to work.
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SciFinder Scholar displays the Selected Reference Explore dialog
box, where you can request information related to the reference.

You may explore in several ways:

• Retrieve the CAS Registry substances – Click this icon to obtain
CAS Registry records for the substances discussed in the reference.

• Explore by one of the authors – Select an author from the drop-
down menu of author names.  Then click the Author icon to start an
Explore by Author Name task.

• Explore by company/organization name – Select a name from
the drop-down menu of company/organization names.  Then click
the Company/Organization icon to start an Explore by Company
Name task.

• Display the selected reference – Click this icon to view the
reference record in SciFinder Scholar.
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Preferences

Appendix A describes the Preference Editor, which can be used to
customize your SciFinder Scholar session.  Preferences are reset to
the system defaults when you exit.

To change default settings, select Edit Preferences from the Tools
menu or click the Prefs button from the Main Menu Toolbar.  The
Preference Editor dialog box is displayed.

The Preference Editor includes options for Display, Print, Explore,
Drawing, Databases, Analyze, Programs (Macintosh only), Save
As, and various Other preferences.

The contents of the Preference Editor change to reflect the settings
currently stored.  To customize options in any area, click the
appropriate tab.  Modify the appropriate options.  When you have
completed your changes, click OK to close the Preference Editor. Or,
click Cancel to disregard the changes.

A
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Click the Display tab in the Preference Editor to customize display
options.  The Display preferences are displayed.  (See the dialog box
on the previous page.)

You may customize the display format of references and/or
substances.  Formats may be changed in the Main Viewer, i.e., the
SciFinder Scholar window, and/or the Viewer, i.e., a “microscope”
window.

You may also change the display of text by modifying the font and
point size.

Available reference formats for both the Main Viewer and the Viewer, as
well as their definitions, are shown in the following table.  The default
reference format for the Main Viewer is Standard.  The Viewer reference
default is Full.

To change the default for either viewer, select a different format from the
appropriate drop-down menu.

Available substance formats for both the Main Viewer and the Viewer,
as well as their definitions, are shown in the following table.  The
substance default for the Main Viewer is Standard.  The Viewer
substance default is Full.

Display
Preferences

Reference Formats

Substance Formats

Menu Item Definition

Compact Displays the title of the article or patent

Standard Displays the bibliographic information with the
author names listed first

Summary
Displays the bibliographic information with the title
listed first followed by the abstract, and, if
applicable, patent family information

Full

Displays the entire record, listing the bibliographic
information (title first), followed by the abstract, and,
if applicable, patent family information, indexing,
supplementary terms, controlled terms, CAS
Registry Numbers, chemical names, and citations
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To change the default format for either viewer, select a different format
from the appropriate drop-down menu.

For reactions, only the Full display format is available.  See Viewing
Reaction Candidates and Viewing Additional Hit Reactions in Chapter 6
for details.

Reference answer sets can be organized in Accession Number Order;
Title Order; or Title, Year Order.  Substance results can be organized in
Accession Number Order or Similarity Order, i.e., similarity to each
other as opposed to the query structure.

For a definition of each sort option, see View Menu in Chapter 2.

The Number of Columns, i.e., the number of substances placed side
by side across your screen, may be set from 1 to 6 columns.  The
default number of columns is 3.

To change the default font, select a different font from the Display Font
drop-down menu.

To change the default point size, select a different font from the Size
drop-down menu.

Sort Options

Text Options

Number of Columns

Reaction Formats

Menu Item Definition

Compact Displays the chemical structure

Standard

Displays the chemical structure, CAS Registry
Number, the approximate number of references
citing the substance, and, if available, links to
additional information

Summary

Displays the chemical structure, CAS Registry
Number, CA Index Name, the approximate number
of references citing the substance, and, if available,
links to additional information

Full

Displays the entire record including the chemical
structure, CAS Registry Number, chemical names,
molecular formula, a list of STN files that contain
information about the substance, property data, the
approximate number of references citing the
substance, and, if available, links to additional
information
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Select the Show “In Memory” status box to display a memory
message at the bottom of the SciFinder Scholar window.  This
message indicates the number of answers that can be listed and read.

This number is system-dependent and relates to the number of
answers your system can hold in its memory.

After modifying your display options, click OK to store your settings
and close the Preference Editor.

Click the Print tab in the Preference Editor to customize print
options.  The Print preferences are displayed.

You may customize print formats for references and substances.  You
may set some special features as well.  Refer to the Special Print
Features section for details.

Print
Preferences

Setting Display
Preferences

Show “In Memory”
Status
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Reference Formats The Print formats for references are identical to those for Display.
Refer to the tables in the Reference Formats section of the Display
Preferences for Display formats and their definitions.  The default for
printed references is Summary.

The Print formats for substances are identical to those for Display.
Refer to the table in the Substance Formats section of the Display
Preferences for Display formats and their definitions.  The default for
printed substances is Full.

To activate these special print features, select one or both of the
following options:

• One answer per page – automatically inserts a page break
between two or more printed answers

• Include answer numbers – inserts answer numbers in your printed
answers (selected by default)

To help identify your printed items, type a header in the Print Header
box.  Headers may be of any length, and is displayed at the top of
each printed page.

To change the default font for printing, select a different font from the
Printing Font drop-down menu.

To change the default point size for printing, select a different size from
the Size drop-down menu.

After modifying your print options, click OK to store your settings and
close the Preference Editor.

Substance Formats

Special Print
Features

Setting Print
Preferences
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Click the Explore tab in the Preference Editor to customize the
explore and retrieval features of structure searches.  The Explore
preferences are displayed.

The default, INCLUDE substance answers where my structure is a
component of a larger system (e.g. mixtures, polymers), retrieves
all substance records that contain the structure that you drew,
including multicomponent chemicals, such as mixtures, in which your
structure is one of the components.  This increases the number of
substances retrieved.  If you are looking for a specific structure that is
very common in multicomponent substances, you may want to
deselect this option.

You may exclude the following substance types:

• Incompletely described substances – The composition and
structure of the parent and substituents are known, but positions of
the attachments are not known, e.g., trichlorobenzene.

• Isotopes
• Metal-containing substances
• Mixtures
• Polymers

Explore
Preferences
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Eliminating one or more of these substance types reduces the number
of substances retrieved.  If you do not exclude a substance type,
SciFinder Scholar will retrieve any substances in these categories that
match your structure.

After modifying your Explore options, click OK to store your settings
and close the Preference Editor.

Click the Drawing tab in the Preference Editor to customize your
Structure Drawing environment.  The Structure Drawing preferences are
displayed.

Setting Explore
Preferences

Drawing
Preferences
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You may select one or more of the following options:

• Valency Checking – warns you about the presence of an abnormal
valence

• Use fixed drawing length – sets bond lengths between 5 and 50
mm

• Use fixed drawing angles – sets bond angles between 1 and 90
degrees

• Show status bar – displays the molecular formula and the
molecular weight at the bottom of the Horizontal Tool Palette

• Display tooltips – displays definition boxes for items in the
Structure Drawing window when the cursor is placed over them

• Node display – displays atoms as either angles, dots, or numbers
at the node positions in your structure.  Only one selection is
permitted at a time.  Selecting one deselects the previous choice.
The default node display is Angle atoms.

You may also select one or more connection table Clipboard Formats
for structures placed on the clipboard with the Copy command from the
Structure Drawing window.  Structures may be copied to the clipboard
in the following formats:

• STN Express
• CS ChemDraw
• ISIS/Draw – MDL molfile

See Appendix B for more information on using the clipboard for
exporting structure queries.

To change the default color for Bonds, Atoms, Selection (selected
bonds and atoms), or Tracking, select a different color from the
appropriate drop-down menu.

After modifying your drawing options, click OK to store your settings
and close the Preference Editor.

Color Preferences

Setting Drawing
Preferences
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Click the Databases tab in the Preference Editor to choose
databases searched with an Explore task.  Database selections may
only be made before you begin a task.

Reference databases offers two choices:

• CAPLUS (cannot be deselected)
• MEDLINE (can be selected or deselected)

If the default order for references is Accession Number Order, the order
that the databases are listed determines the order that references are
displayed.  To change the order, click the name of a database and then
click Move Up or Move Down.

The Structure database is REGISTRY.

The Reaction database is CASREACT.

After modifying your databases options, click OK to store your settings
and close the Preference Editor.

Database
Preferences

Setting Database
Preferences
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Click the Analyze tab in the Preference Editor to customize the
Analyze and Refine features.  The Analyze References and Refine by
Property preferences are displayed.

Select an option from the Histogram Entry Sort Order section to
customize the order of Analyze results.  You may choose to arrange
the results in Alphabetical order or By Frequency.  The default is By
Frequency.

Select Display intermediate Analyze results to view results as they
are processed.  This is selected by default.

In the Refine by Property section, you may set Default Values and
Default Properties for the Refine by Property feature described in
Chapter 5.

Analyze
Preferences
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Enter or select ranges of interest for the properties listed in the Default
Values box.  In the Default Properties list, select the properties you
would like to have selected by default for the Refine by Properties
feature.  Select Include substances with no value for the specified
properties to ensure that substances without values available are
retained in your answer set.  Click Restore SciFinder Defaults to
return the values to their original settings.

After modifying your Analyze and Refine options, click OK to store
your settings and close the Preference Editor.

Setting Analyze
Preferences
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Click the Programs tab in the Preference Editor to customize
applications to launch automatically when specific file types are
accessed within SciFinder Scholar.  The Programs preferences are
displayed.

At present, Acrobat and Internet documents are the only file types that
can be found within SciFinder Scholar data.

To add an application to your Programs preferences, click Add.  The
Add Program dialog box is displayed, where you can enter the
appropriate information.  Click OK to save the information and insert the
application into your program list.

To edit information about a application, select it and click Edit.  The
Edit Program dialog box is displayed, where you can make the
appropriate changes.  Click OK to save the changes.

To delete an application from the list, select it and click Delete.  You
are not given a confirmation dialog box for deleting applications.  If you
change your mind, click Cancel to retain your previous list.

After modifying your Programs settings, click OK to store your settings
and close the Preference Editor.

Setting Programs
Preferences

Programs
Preferences
(Macintosh only)
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Other
Preferences

Click the Other tab in the Preference Editor to customize Colors and
Animation and other Options.  These preferences are displayed.

To change the color of highlighting, hypertext, or histograms, select a
different color from the appropriate drop-down menu.  The default colors
are blue for text highlighting, red for structure highlighting, purple for
hypertext, and blue for histograms.

To change the animation that displays while SciFinder Scholar retrieves
information, select a different option from the Animation box.  You
may select from three different animations.  These are shown in the
bottom right-hand corner of all applicable windows.  The default
animation is a Flask.

Color and animation changes take effect immediately.

Colors and Animation
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Setting Other
Preferences

The Show confirm dialog upon new task box is used to
automatically display a message when you begin a new task that will
remind you that the task you are leaving has not been saved.  This
option is off by default.

The Audible alert when search is complete option sounds an alert
when your SciFinder Scholar search has finished.  This option is on by
default.

The Confirm upon new task if structure data is unsaved option
should be selected if you want SciFinder Scholar to notify you that the
structure task you are about to leave is not saved.  This is on by
default.

The Use secure sockets for ChemPort ordering option is available if
you want to use secure measures when ordering documents via the
Web through ChemPort.  This is off by default.

The Browse on a single window option allows Windows users to use
the same browser window for all Internet link requests.  If deselected, a
new browser window opens for each request. This option is on by
default.

The Highlight query in structure answers option highlights the
portion of a structure answer that matches the drawn structure.  It is on
by default.

After modifying your Other options, click OK to store your settings and
close the Preference Editor.

Options
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Save As
Preferences

Click the Save As tab in the Preference Editor to customize Save As
options.  The Save As preferences are displayed.

The Save As formats for references are identical to those for Display.
See the Display Preferences section at the beginning of this appendix
for details.  The Main Viewer default format is Summary.  The Viewer
default is Full.

The Save As formats for substances are identical to those for Display.
See the Display Preferences section at the beginning of this appendix
for details.  The substance default for the Main Viewer and the Viewer
is Full.

Substance Formats

Reference Formats
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Setting Save As
Options

Answer Key Options

Quoted Options Select characters to define terms and to separate entries by choosing
from the Quote Character and Delimiter drop-down menus,
respectively.

The defaults (“ and ‘) are the most commonly used characters for the
Comma-Separated Value (CSV) format that is used for input into
spreadsheets, e.g., Excel, and database programs, e.g., Filemaker
Pro.  Numerous other options, including tab-delimited, can be specified
with these settings.

Select Include Database Name to show the database from which that
record was retrieved.  This option is on by default.

Also select from the Delimiter drop-down menu to identify how you
want to separate answers.  (<NEWLINE> is the default.)

After modifying your Save As options, click OK to store your settings
and close the Preference Editor.
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